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a laptop? Hows

A MESSAGE
FROM DRU

Well, we've come full circle to
the end of another year. Let me
stop, for just a moment, before
we all get too caught up in the
spirit (and the hustle and bustle)
of the holidays, to say it has
been a honor to serve you
throughout the years. This year
marks the end of our 19t year in
business. In this, or any other,
economy, businesses that have
the staying power to survive for
as long as we have are a rare
commodity indeed. And it couldn’t
have happened without all of you.
Thank you, thank you, thank you.
Happy Chanukkah. Merry
Christmas. Merry Kwanza! Does
that cover everyone? :-D

Need a Holiday gift for a family
member, friend, or loved one?
Have | got a computer for you! G4
Tower Systems starting at $250—

Great Starter Systems. How about
about $300?!? WOW! All-in-Ones?

I've got e-Macs from $275. I've got G5 iMacs and G5
Towers! Call the office today.

For those that care about such things department—I will
be undergoing an angiogram on Monday December 21st.
What that means is that | will be out of pocket for all of
Monday and, depending on what (if anything) the
cardiologist finds, possibly Tuesday. I'll keep y’all posted.
There’s still time to hire my band, LoveSong, for a holiday
party. Well, actually, it doesn’t need to be a holiday party.
It could be a birthday party. Or a wedding anniversary
celebration. Or a corporate event. [We're very flexible!]
Call the LoveSong line at 972-783-9790 for more info,
availability, and pricing.

-

HAPPY HOLIDAYS!
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Design basics:
rocks

Repetition

by Lesa Snider

Even if you've never attended a single
art class, you can still design creative
and easy-to-read documents for any
occasion. Just keep in mind some easy
principles, and you’ll wind up creating
interesting—even compelling—posters,
cards, invites, newsletters, and other
everyday items.

Repetition, repetition, repetition
Whether you're creating a tri-fold
brochure, an 800-page book, or a 1/4-
page ad, repetition will give your piece
a cohesive feel by introducing
consistency. Have you ever noticed
that newspapers, books, and manuals
all have headlines, subheads, and
header/footer styles that look the same
throughout? This makes each page
feel related, even though the content is
different.

Case in point: Recently, | received a
brochure in the mail with a butterfly
illustration on the cover. As | unfolded
it, the butterfly appeared again and
again, though smaller and in different
positions. Finally, the butterfly
appeared on the back at bottom right,
giving me the impression it had “flitted”
through the brochure and landed at the
end. “What a clever design,” | thought.
To introduce repetition into your
designs, simply pick an item in your
layout—a graphic, font family, or color
—and repeat it throughout the piece. In
the example below, feathers were
repeated to draw attention to important
details, the text color was snatched
from the logo, and bolding was
repeated for the first line of text in each
block.
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Introduce repetition into your designs by picking
an item in your layout and repeating it throughout
the piece.

Depending on the program, repetition
can be as simple as selecting an item
and using copy and paste. However, if
you’re using a program that supports
layers—such as Photoshop, lllustrator,
or InDesign, here are a more few tips.

Duplicating layers If the repeatable
item lives on its own layer, you can
duplicate that layer by activating it and
pressing Command+J. If you have a
selection (marching ants), this shortcut
will jump the selection onto another
layer.

Ungrouping artwork If you're working
with artwork from Adobe lllustrator, you
might need to break it apart in order to
select the piece you want (like the
feather below). If that’s the case, select
the entire thing, choose Object ->
Ungroup and then use the Selection
tool to grab the bit you want. You can
also copy an item in lllustrator and
paste it into InDesign. Sweet!

In lllustrator, select just a portion of the artwork
to isolate the part you want to use.

Step and Repeat Both InDesign and
QuarkXPress let you repeat an item
any number of times at an equal
distance of your choice. After selecting
the item, choose Edit -> Step & Repeat
in either program.

Copying color If the program you're
using has an Eyedropper tool—such
as Photoshop, lllustrator, or InDesign—
you can use it to snag color from
elsewhere on your page. Just highlight
the text, activate the Eyedropper tool
(circled below) and then mouse over to
where the desired color lives and click
to apply (you'll see the new color

appear in your Tools panel, as
indicated below).
o

Codorado Chautaug

Match color from somewhere on your page.

Continue on Page 9
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Apple's iMac sales jump 74%
in U.S.

Even Apple couldn’t have expected a
sales jump this big, says analyst

Sales of Apple’s iMacs in the U.S.
jumped 74% during October and
November over the same period last
year, a retail research firm said today,
making the desktop line refresh “a very
big success.”

iMac sales during the first two months
of the final calendar quarter were up so
dramatically that it had to take even
Apple by surprise, said Stephen Baker,
analyst with the NPD Group. “They’ve
reaccelerated that [desktop] segment
for Apple,” said Baker, noting that the
21% jump in overall Mac sales were
largely due to iMac sales. Sales of
Apple’s laptops the MacBook,
MacBook Pro and MacBook Air --
increased by just 5% year-over-year
during October and November.

“It's hard to imagine Apple could have
predicted those iMac sales, especially
of the 27-in. models,” said Baker.

Although sales of the less-expensive
21.5-in. iMacs were greater than those
of the pricier 27-in. version, the big
boost in sales of the latter, when
compared to previous sales of Apple’s
top-of-the-line iMacs, was the big
surprise to Baker.

“Apple often gets a big jump in sales
after a refresh,” noted Baker, “and
we’re on the cusp of that six- to eight-
week period. We saw a big jump in
March when Apple tweaked the
internals of the iMac, but that didn’t
have the legs that this one seems to
have.”

Apple launched its revamped iMacs on
Oct. 20, replacing the earlier 20- and
24-in. displays with 21.5- and 27-in.
screens, and offering quad-core
processors on the larger models for the

first time. The 21.5-in. model starts at
$1,199; the 27-in. version starts at
$1,699, with the quad-core model
going for $1,999.

When asked why the iMacs have done
so well — a turnaround of sorts for
Apple, which has seen desktop sales
drop steadily over the past several
years — Baker said simply, “l wish |
knew.”

Apple Wins Permanent
Injunction Against Psystar

On Tuesday, Apple won a permanent
injunction against Psystar following
summary judgement in favor of Apple’s
claims of copyright infringement and
violation of the DMCA. (court
document PDF). The court orders that

Psystar is now prevented from the

following:

1. Copying, selling, offering to sell,
distributing, or creating derivative
works of plaintiff’s copyrighted Mac
0S X software without
authorization from the copyright
holder;

2. Intentionally inducing, aiding,
assisting, abetting, or encouraging
any other person or entity to
infringe plaintiff’s copyrighted Mac
OS X software;

3. Circumventing any technological
measure that effectively controls
access to plaintiff's copyrighted
Mac OS X software, including, but
not limited to, the technological
measure used by Apple to prevent
unauthorized copying of Mac OS X
on non-Apple computers;

4, Manufacturing, importing,
offering to the public, providing, or
otherwise trafficking in any
technology, product, service,
device, component, or part thereof
that is primarily designed or
produced for the purpose of
circumventing a  technological
measure that effectively controls
access to plaintiff's copyrighted

Mac OS X software, including, but
not limited to, the technological
measure used by Apple to prevent
unauthorized copying of Mac OS X
on non-Apple computers;

5. Manufacturing, importing,
offering to the public, providing, or
otherwise trafficking in any
technology, product, service,
device, component, or part thereof
that is primarily designed or
produced for the purpose of
circumventing a  technological
measure that effectively protects
the rights held by plaintiff under the
Copyright Act with respect to its
copyrighted Mac OS X software.

Psystar must come into compliance by
December 31, 2009 at the latest and
take the quickest path to compliance. It
seems this order marks the end of
Psystar as well as the hope of any
other company from following in their
footsteps.

Psystar made headlines back in April
when it started advertising
unauthorized Mac OS X compatible
PCs. Apple subsequently sued Psystar
on grounds of copyright infringement
as well as DMCA claims. Apple had
won summary judgement in November.

Apple's $85M purchase of
Lala paves way for iTunes
cloud

Apple’s purchase of music streaming
service Lala signals a fundamental
change in the way that the company
will present iTunes content on the web.

Apple is poised to totally change its
iTunes business model with a
increased focus on Internet-based
content, reports the Wall Street Journal
in an article appearing in Thursday’s
edition.

Continue on Page 10
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Q: My backup hard drive LACIE
doesn’t show an icon on my desktop.
How do | recover files from it?

A: When a hard drive ’falls off the
desktop’ it is always disconcerting. The
good news is that most of the time it’s
a simple matter of restarting the
external hard drive and/or the
computer to get it to reappear on the
desktop. If that doesn’t work try going
to the Disk Utility program in the
Utilities Folder and running that. If that
doesn’t work, call me!

Q: I'm thinking of upgrading to Snow
Leopard (Mac OS X 10.6) but I'm not
sure that it'll work with my peripherals
and other programs. Is there a place |
can look to see if it works before |
invest in the program?

A: To see if your software is compatible
with Snow Leopard check here - http:/
snowleopard.wikidot.com/ - or here -
http://www.macintouch.com/
specialreports/snowleopard/
slcompat.html . To check your printer
or scanner check on the
manufacturer’s web site and download
new drivers, if necessary.

Q: Can you tell me how | can block
emails?

A: I'm assuming you mean spam (and
NOT the (somewhat) edible variety. As
you have probably already found out,
blocking e-mails isn’t easy. Spammers

are wily creatures. It's next to

impossible to block e-mails by using a

word or phrase. The best way I've

found it to create a ‘rule’. Here’s how -

1. In Apple’s Mail program go to
Preferences/Rules.

2. Click on ‘Add Rule’

3. Give the rule a description, like ‘No
Russians, etc.

4. Set conditions to ‘any’

Here’s where your conditions go. In

this case if <From> <Contains> <.ru> -

the action to be performed is to <Move

Message> to <Trash>. ‘“ru’ is the

country code for Russia. So this rule

says, ‘Any messages that comes from

Russia, send to Trash.

You can have as many rules as you

want and each rule can have as many

conditions as you need.

Q: My MacMail program has been
quitting on me frequently within the last
week or so. Each time | send a report
to Apple. | get an alert that the program
has quit unexpectedly and would | like
to relaunch? Also, | frequently see the
icon next to one or more of my
accounts that it is currently offline, so |
have to go into preferences and tell it
to bring all accounts online. Any
thoughts on what is causing this and/or
the program quitting?

A: In many cases when the Malil
program quits its because it can’t
connect with either the POP (Incoming)
Mail Server or the SMTP (Outgoing)
Mail Server. You need to check to see
if your settings are correct (including
your password). If everything is in
order, it might be the Mail preferences.
If all else fails, you can delete the mail
account and then re-install it. But be
very careful here. Make sure that
you’ve backed up your mail BEFORE
you delete the account.

Q: My problem is that the MacBook
Pro does not recognize my Xerox
8550DP which is plugged into my

airport extreme via ethernet. Please
help!

A: One of the advantages of using an
Airport Extreme Base Station is that
you can hook up a printer to it and then
everyone who connects wirelessly to
the Base Station can also print
wirelessly.

To make this configuration work you
have to install the correct pinter driver
into your laptop. Once that’s done, go
to the Airport Utility (Applications/
Utilities) and go to the Printer section
and make sure that the printer is listed.
If it is, you’re done. You can now print
wirelessly from your laptop to the
printer.

Q: After | print something the printer
icon remains in the dock and | have to
manually quit it. How do | fix it so it
automatically quits after printing and
disappears from the dock? | looked in
the menu bar but can't figure it out.

A: If you're running Leopard or Snow
Leopard, click and hold the printer icon
in the dock. In the pop-up menu, select
‘Auto Quit’. That’s it. Simple!

Q: | want to type in Japanese . How do
| do this?

A: Believe it or not , it’s not really that
difficult. Go to Preferences and select
the International Pane. Click on the
‘Input Menu’ tab. From there you can
select the ‘Japanese Kana Palette’.
Then click the Kotoeri box to activate
the Hiragana, Katakana, and Romaji
Inputs.

This doesn’t mean that the Mac will
translate Japanese —English—
Japanese. Youll need another
program to do that. But remember you
have a built-in translation widget in
Dashboard.
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Does Apple Build the Gear
You Want?

by Gene Steinberg

A big part of the recent debate over
Apple pricing and that alleged Apple
Tax is whether Apple is forcing you to
pay for loads of options that you don’t
want. This is certainly the most
significant argument about the whole
issue, because even if a comparably
equipped Mac and PC are similar in
price, it doesn’t matter if Apple isn’t
building the computer that best suits
your personal requirements.

This is one of the reasons why |
suggested a possible business
configuration. Now it’s clear to me that
it's far cheaper for Apple to supply
Bluetooth and Wi-Fi preinstalled on the
logic boards, and the extra money you
pay is probably not a large figure. If
you had to buy specialty daughter
cards to get these features, Apple
would have to design and test
separate components along with an
interface that allowed them to connect
properly. It would mean that the
majority of people who want one or
both would end up paying more for
their new Macs.

That’s a critical point. Despite the
erroneous claims in a recent issue of
Consumer Reports that Apple’s new
iMacs delivered more without a “hefty”
price increase, Apple generally keeps
the price the same or delivers higher-
end configurations for less when they
upgrade products. Bundling everything
as standard equipment reduces their
production costs, and thus the retail
price if Apple chooses to pass on those
savings to you.

So in constructing that business-
oriented Mac, I'd leave in the wireless
networking. Then again, if you include
the MacBook, MacBook Pro and iMac,
all of which have built-in Web cams as

well, eliminating all three might indeed
produce a slight savings, which |
estimate to be $50 to $75 per unit.
That may mean very little if you're
buying just one, but when you order up
hundreds or thousands of Macs
similarly configured, pretty soon it adds

up.

However, | think most of you realize
that Apple has not invested much time
or energy devising an enterprise
strategy. Instead, they  expect
businesses to simply use the same
Macs that are sold to consumers. In
large part, they’ve been successful,
because more and more businesses
have at least some Macs around the
office. Indeed, there appears to be less
resistance on the part of IT people who
traditionally favored Windows. But |
suspect part of that is due to the fact
that corporate executives end up
buying new Macs and then telling the
systems people that they just have to
accept the situation and deal with it. It’s
also true that Apple has made it easier
and easier to integrate Macs into
Windows networks with each Mac OS
X upgrade.

The other question is more serious in
its implications. Does Apple provide the
products you, as a consumer, want to
buy, or are you compromising big time
to go Mac? This is the real issue raised
by that Apple Tax claim, because Apple
sells fully loaded personal computers,
brimming with the latest and greatest
technology. The average sales price is
way above that of the average PC.
Indeed, roughly 50% of the money
spent on personal computers in the
U.S. retail market goes to Apple. But
their actual market share is still
between eight and nine percent overall
in this country.

This doesn’t mean Apple is building
overpriced gear. They have opted to
pick and choose the market segments
in which they operate, avoiding the

cheap PC playground, where bottom
feeders fight relentlessly for higher and
higher sales, profit margins be
damned! There’s no way Apple
expects to be successful playing that
game, anymore than they will build a
standard wireless handset. When it
comes to mobile phones, the big
money is in the smartphone segment.

After all the bad moves Apple made in
the 1990s, their present strategy is a
good thing. Sales are high, profits are
high, and most customers love their
iPhones, iPods and Macs. Why should
it be otherwise?

This doesn’t mean that Apple will never
produce the exact computer you want,
if you can’t find it in their current lineup.
It's still all about sales and customer
demand. At the end of the day, if Apple
sees sales tanking in a particular
market, they’ll do something about it.

Consider, if you will, Mac desktops.
Sales are down industry-wide, not just
with Apple. Some three quarters of all
Macs sold these days are notebooks,
at least according to the most recent
quarterly financials. So in creating a
new iMac lineup, Apple gave you larger
screens and also a special quad-core
configuration that, for now at least,
trumps the Mac Pro in many
performance benchmarks. Indeed, |
expect many content creators who
found the Mac Pro too rich for their
blood are opting to select quad-core
iMacs instead. This is a move, by the
way, that I've seriously considered, and
I’ll let you know my decision soon.

Meantime, if you still want Apple to
make a computer that’'s not in their
current lineup, such as that mythical
midrange Mac minitower — basically
an iMac without the integrated display

Continue on Page 9
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TypeStyler X (v.10.6)

Font package adds package mockups
and 3D animations to powerful text
effects

by Jay J. Nelson

TypeStyler is more than 20 years old,
and to employ an overused but apt
phrase, this version is definitely not
your father’s TypeStyler. The type-
effects application has been on hiatus
for about seven years, but has now
returned with a new version designed
for the latest Mac operating systems.

You may remember TypeStyler as a
font utility that facilitated an easy way
to twist and distort type, while
maintaining its editability. TypeStyler
still does that, but its developers have
dramatically expanded its feature set to
make it uniquely valuable for designing
packages, creating spinning graphics,
and laying out single-page documents
such as flyers, ads, sell sheets, and
invitations. The program’s ease of use
and advanced creative features make
it valuable for all designers and
especially for those who are still
learning the craft.

Type effects

First and foremost, TypeStyler lets you
create impressive text effects. Nothing
will freeze your creativity like staring at
a blank page with hundreds of tool
options. Thankfully, TypeStyler has
dozens of pre-built styles that you can
instantly apply to your text, and then
adjust in dozens of ways. It also has
more than 100 pre-built logo designs
that you can use as starting points for
your projects.

For example, you can begin with a
puffy gel type effect, fill it with a photo
(or photos), change the hue and scale
of the gel effect, and add several kinds
of drop shadows: Drop, Cast, Block, or
Zoom. You can move the drop shadow

around by simply holding down the
Option key and dragging it. You can
stroke the text outline with colors,
blends, jellies, or even an image.

The text remains editable, so you can
change the words or choose a different
font with the effects applied to the new
text. If you've chosen a swoop or twist
effect (for example), you can choose a
different kind of shape distortion, or
edit the shape with standard Bézier
anchor points and handles. And unlike
previous versions, you can use
multiple fonts in a single text box.

Once you've settled on an appearance
that you like, you can break the letters
apart to drag them around, or edit their
individual paths. This is a great way to
get your main look and shape, and
then customize individual letters for a
logo.

Page Layout

TypeStyler now include rulers, guides,
and multiple text and picture
containers, making it suitable for
single-page layouts. It even includes
more than 100 templates as starting
points. TypeStyler places each object
on its own layer with adjustable
visibility and opacity. The Object
Palette also provides a quick way to
select and edit one object or lock it.

The program includes dozens of useful
shapes, which are editable. You can
also pluck a glyph from any active font,
and edit it as a shape in TypeStyler.
Shapes can be filled with blends or
images, and in many ways. For
example, you can tile images by
mirroring them inside the shape or by
rotating them around a central point,
for a unique kaleidoscopic effect. You
can insert images by dragging them
from TypeStyler's handy Media
Browser, which automatically shows all
photos in your iPhoto library, along with
images in any folder you choose.

One of the features | enjoy the most is
the Shape Designer. In particular, the
Star Designer lets you begin with a
standard star shape, and then by
dragging sliders you can create
unusual (yet useful) shapes that
remain editable after applying effects
to them. Other starting shapes include

rounded rectangles and ovals,
polygons, and arcs. By simply click-
holding on the Shapes icon in

TypeStyler’s toolbar, you get variations
of standard shapes to customize at
will.

Packaging

TypeStyler now includes an impressive
collection of 3D shapes to which you
can apply your own artwork: Plane,
Disc, Box, Bag, Sphere, Cylinder,
Cone, Torus (doughnut), Teapot, Can,
Bottle, Jar, and Orbit. This feature in
itself may justify its purchase for
package designers. Not only can you
wrap your artwork around these
shapes, you can rotate them in real
time, in 3D space, and then take a
snapshot at any angle. The artwork
can be created in TypeStyler or
imported in any common image file
format.

After you apply your artwork or label to
a shape, you can adjust the shape’s
opacity and choose a material such as
plastic, metal, or glass. You can apply
up to up to six layers of objects to a
shape, with adjustable opacity, size,
and position.

To assist professional  graphic
designers who use Adobe products,
TypeStyler lets you save your creations
as layered native Photoshop or
lllustrator files, including transparency,
to include or adjust in those
applications. Or, you can simply export
your design as an image at any
resolution,

Continue on page 9
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iPhone Camera

Yes, we need to click a button to take a
photo, whether on a digital camera or
with your iPhone. But the secret with
the iPhone is whether we click or re-
lease.

The Camera app’s button doesn'’t take
a photo until you release the shutter
button. Of course, when we see the
button, we think press and release. But
it doesn’t have to be so simple.

So do this: press and hold the button
as you frame your shot. You can still
set a focus area on the iPhone 3GS
with the button held down. When
you're ready to take the picture, re-
lease the button. This technique mini-
mizes camera movement because you
don’t have to both press and release
the button with your finger.

Sweet!

This releasing of the button helps to
frame the shot and to avoid camera
motion.

| have also found this tip helpful when
taking a photo in low light conditions.
Here’s my technique: | hold the iPhone
in my right hand as | might a bottle with
the edge of my palm on a table or
other object and with my thumb
straight up, bracing the top edge of the
iPhone. Then | use my left index finger
to hold the button down on the screen.
I's essential here to not push the
iPhone against your left hand finger
because then the camera will move
when you release the button. Instead,
it's all about pushing down on the
iPhone with your right thumb, which
anchors it.

iTunes compilations: what
holds them together?

When you rip a CD in iTunes—or when
you buy an album from the iTunes
Store, Amazon, or other vendor—there
are a number of tags you can set, such

as the album name, artist name, and
genre. But there’s one tag that seems
to confound a lot of iTunes users: the
compilation tag. Here’s an overview of
what the compilation tag means, what
it can do for you, and how to work with
it.

First, what exactly is a compilation?
Technically, it’s an album with multiple
artists but not, for example, a best-of
album by a single artist (although the
iTunes Store does in fact consider
many Greatest Hits albums to be com-
pilations). Since iTunes and the iPod
can sort music by artist, when you go
to view an album by a given artist, you
expect to find full albums. But with
compilations—say a movie soundtrack
with songs by ten different performers,
or a Time Life collection of the greatest
cowboy songs to sing along with in the
shower—you’d only find one or two
songs under an artist's name. Also,
you wouldn’t be able to play the entire
album without creating a playlist for it,
or by searching for the precise album
name. For this reason, iTunes has a
compilation tag that you can set to give
special status to these “various artist”
collections.

Multiple Item

Info  Video  Sorting - Options

Volume Adjustment: a4

Equalizer Preset

Media Kind
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Skip when shuffling: | No O]

Gapless album No -+

Cancel ) (0K )

You can change the compilation status of any
album by selecting its tracks and choosing Yes
or No from the Part of a compilation menu.

Setting this tag on a group of tracks—
it's one you toggle between Yes and
No—has a number of effects. First, it
groups the album together rather than

leaving the music spread out among its
various artists (as long as all the tracks
have the same album name). For ex-
ample, if you use the iTunes Browser
(Command-B shows or hides the
Browser, and the View -> Column
Browser submenu lets you choose how
it's displayed), tracks in compilations
won’t show under the names of their
artists, unless you have other, non-
compilation albums by the artists on
the compilation. If you have the Com-
poser tag filled, however, all tracks
from compilations will show up in the
Composer column of the Browser. A
practical option in iTune’s Advanced
preferences lets you group compila-
tions at the top of the browser: check
Group Compilations When Browsing,
and you’ll see a Compilations entry at
the top of the Artists column so you
can find your compilations easily.

Setting an album as a compilation—or
not—is easy to do. Select all its tracks,
then press Command-l, and click the
Options tab. Choose Yes or No from
the Part Of A Compilation menu, then
click OK.

Viewing compilations on your iPod is a
bit different from iTunes’ solution;
there’s no option to group compilations
under the Artist menu, but if you go to
Settings -> Music Menu, you can
check Compilations and have your
iPod display a Compilations sub-menu.
On an iPhone or iPod touch, however,
Apple decided that it would be better to
list songs from compilations under their
artist names. However, you have a
choice; if you tap Music, then More,
there’s also a Compilations menu, so
you don’t need to change any settings
to find your compilations. Unfortu-
nately, you can’t turn off the display of
compilation tracks in the Artists list,
and if you have a lot of compilations,
your Artists list can get pretty long.

Continue on Page 9
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Only A Game
by Daniel Jalkut

What is it about my job that
makes it so damned enjoyable?
| was discussing this earlier
today with a friend and came to
the conclusion, perhaps
obvious, that it's fun because
running an indie software
business feels like playing a
game.

| imagine that other small
business owners, and larger
venture entrepreneurs feel the
same way. What a luxury to be
immersed in this environment
where every decision ultimately
rests upon my shoulders.
Whether | win or lose depends
entirely on how | choose to
move the pieces.

Of course this freedom and
autonomy comes with a few
downsides. In particular, playing
the game can be stressful, and
the consequences of losing can
be dire. The indie software
business is a long, sometimes
tedious game with no extra
lives.

| believe that the best game
players are those who
acknowledge they might lose,
but who really, really, really,
really, really, really don’t want
to.

By acknowledging a risk of
failure, you implicitly
acknowledge:

1.  You are willing to accept
the consequences of
losing.

2. The choices you make in
playing the game affect
the outcome.

This is good. Somebody who is
blindly assured of winning is
liable to play games that they
can’t afford to lose, and to play
them with foolish ignorance of
the rules. Knowing you can
afford to lose liberates your
thinking so that you can play the
game for the game’s sake. And
your strong desire to win
encourages you to seek out the
wisest moves at all stages of

play.

| often hear the opposite
mentality celebrated. “Failure is
not an option.” “Nobody told me
it was impossible, so | did it.” “If
you build it, they will come.”
These are fantastic rallying
cries, but they don’t reflect the
true attitudes of a wise game
player. They make a romantic
postscript to games that were,
ultimately, won.

Running your own business isn’t
the only way to treat your job as
a game. | always found framing
the expectations and
achievements of work in a game
context made the work more
fun, even when | was working
for other people. Whether that
was racing to fix bugs in time for
a deadline, or counting the
number of envelopes | could
stuff in 60 seconds.

But the game has never been as
complex or enjoyable as it is
now. Running Red Sweater is

incredibly challenging. | make
decisions every day that could
be the foolish move that leads to
my failure, or the stroke of
genius that guarantees my
success.

| know there is a chance of
losing, but | really, really, really,
really, really, really don’t want to.
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Repetition, cont.

As you can see from the final product
below, a little repetition goes a long
way toward giving your designs a more
cohesive feel.

Midsummer NBight
Masquerade ©

» Asnocia

The final product, by itself.

iTunes, cont.

While compilations can be great, they
can also be a headache. Let’s say you
rip a CD and can’t find it in your library.
This can happen if the Gracenote tag
information, which iTunes searches for
on the Internet when you insert a CD,
has the Compilation tag incorrectly set
for that album. You can change it, of
course, but you may scratch your head
trying to find the album to do so. For
this reason, you might want to always
have compilations display in the
browser (assuming you use the
browser), or create a smart playlist with
the condition Compilation is true, so
you can always find your compilations.

Another problem related to the
Compilations tag occurs when only
some songs of an album have that tag
set. You may find an album in iTunes
that shows as if it were two separate
albums. Select all the tracks and set
the Compilation tag to No to group the
songs correctly.

One final
compilations.

curiosity  related to
Since iTunes doesn’t

record these albums by the names of
their artists, it stores the files in a
special way. In your iTunes Media (on
iTunes Music) -> Music folder, you'll
find a folder named Compilations with
all of albums tagged as such.

Type Styler, Cont.

or as a print-ready PDF. You can also
print directly from TypeStyler with all
the necessary fold and cut lines
included to construct a physical
mockup of the chosen shape.

If the package is too large for your
printer, TypeStyler can tile the pages
for you, with appropriate overlaps.

3D Animations

Within the Visualizer is an Orbit feature
that lets you export animations of your
artwork spinning around several globe
shapes, with control over the spin rate
and size. Presets permeate every
aspect of TypeStyler, and Orbit is no
exception—the Sphere shape includes
a baseball, soccer ball, and beach ball
that you can use for your animation. If
that's not enough, you can even
overlay digital video onto the globe,
including live video from your iSight or
another camera, or from a movie file.
From there, you can export your
animation as a QuickTime movie, with
control over frame rate. This feature is
tremendously valuable for creating
introductions to presentations, DVD
menus, or your own TV shows. You
can also export the movie to any
FireWire camcorder.

All 3D models can be placed against a
collection of impressive backdrops,
with perspective effects. Backdrop
presets include Bronze Floor, Theater
Stage with Lighting, Red Nebula,
Cathedral Panorama, iSight Camera,
Movie, your picture(s), and Quartz
(Raindrops). You can even mix two

backgrounds. A second set of
background presets includes Wood
Floor, Stage Curtains, Sunset on the
Water, City Lights Panorama, iSight
Camera, movie, quartz (Clouds). The
backdrop color, texture, shape, and
other attributes are also editable.

Limitations

A number of the program’s limitations
are related to the Visualizer. For
example, when switching applications,
TypeStyler’'s 3D Visualizer window
floats above the windows of some
other applications to facilitate drag-
and-drop. It’s annoying but not deadly.
Some of the 3D Visualizer’s controls
appear and are functional even when
they cannot affect the current item,
which can be confusing. Plus, the
Visualizer is not available on PowerPC
Macs or Intel Macs with integrated
graphics cards.

At this writing, TypeStyler X has no
Help files or written documentation, but
| found the program’s popup tool tips
comprehensive enough to assist with
most tasks. The developers promise to
add how-to videos to the Website, as
well as a manual in PDF format in the
near future.

Buying advice

What impressed me most about the
new TypeStyler X version 10.6.47 is
the number of useful presets and
visual previews it includes. In just
about any mode, you can choose a
preset, see a preview of it, and then
customize the effect with sliders to see
the result in real time. The breadth and
depth of its typographic features and
constant visual feedback make it
perfectly suited for teaching many
aspects of graphic design. Its
packaging mockup capability should
place TypeStyler into the toolkit of most
graphic designers, and its 3D rotation
features will be welcome for anyone
who wants to spruce up a presentation,
DVD menu, or video project.
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Apple purchase, cont.

Using newly acquired La La Media Inc.
as a springboard, Apple is considering
to adopt a usage model that would
allow consumers to access and
manage their iTunes purchases
directly through the Internet without
downloading the content in question or
the iTunes software.

In its current form, iTunes requires
users to download and manage their
iTunes purchases on a per-computer
basis. With a new focus on Internet-
based management, an iTunes user
could log into their account and access
and stream all their music from any
computer with an Internet connection.
This technology could also allow Apple
to sell music on other websites or even
in web-based search results.

Apple has already made some small
strides into  web-based iTunes
functionality with the release of iTunes
Preview in November. With iTunes
Preview, users can share music links
via iTunes without the need to launch
Apple’s media suite. Previously, users
without iTunes were prompted to install
the software in order to view content.

The Wall Street Journal’s figure of $85
million for Lala’s purchase price is in
the same ballpark of what Peter Kafka
at AllThingsDigital reported Monday.
The report also confirms what Maynard
Um predicted about Apple’s reasons
for aquiring Lala earlier this week.

Lala execs have already assumed
important roles in shaping Apple’s
iTunes strategy going forward. “It's our
understanding that the Lala guys are
going to be in very significant roles,”
someone familiar with Apple’s plans
reportedly said.

Apple’s $1 billion server farm project
planned for North Carolina may
actually be tied to this web-based

strategy, and could provide the
backbone for a web-based iTunes.

Thanks for taking the time to read this
month's newsletter.

Hope you enjoyed it. If you have any
comments or suggestions for stories
(or would even like to write a story ~
hint, hint, hint), please send them to

me at: machelpdesk@tx.rr.com

Feel free to share this newsletter with a
friend. The newsletter archives are
located at: http:/

www.machelpdesk.com/page6a.html

Y'all come back now, y'hear.
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